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Chapter 1. Troubleshooting

Troubleshooting, or problem determination, is the process of determining why a certain product is
malfunctioning.

Note: You can resolve some problems by ensuring that your system matches the system requirements
listed in the IBM Tivoli Monitoring Windows OS Agent Installation and Configuration Guide.

See the following documents for general information about using the product:
v IBM Tivoli Monitoring Troubleshooting Guide

v IBM Tivoli Monitoring Administrator's Guide

v IBM Tivoli Monitoring User's Guide

Gathering product information for IBM Software Support
Before contacting IBM® Software Support about a problem you are experiencing with this product, gather
the following information that relates to the problem:

Table 1. Information to gather before contacting IBM Software Support

Information type Description

Log files Collect trace log files from failing systems. Most logs are located in a logs subdirectory
on the host computer. See Chapter 2, “Trace logging,” on page 3 for lists of all trace log
files and their locations. See the IBM Tivoli Monitoring User's Guide for general
information about the IBM Tivoli Monitoring environment.

Operating system Operating system version number and patch level. Use the systeminfo command to
obtain information about the operating system.

Messages Messages and other information displayed on the screen

Version numbers for
IBM Tivoli Monitoring

Version number of the following members of the monitoring environment:
v IBM Tivoli Monitoring. Also provide the patch level, if available.
v IBM Tivoli Monitoring: Windows OS Agent

Use the command install_dir\InstallITM\KinCinfo -i.

Screen captures Screen captures of incorrect output, if any.

Built-in troubleshooting features
The primary troubleshooting feature in the IBM Tivoli Monitoring: Windows OS Agent is logging. Logging
refers to the text messages and trace data generated by the IBM Tivoli Monitoring: Windows OS Agent.
Messages and trace data are sent to a file.

Trace data captures transient information about the current operating environment when a component or
application fails to operate as designed. IBM Software Support personnel use the captured trace
information to determine the source of an error or unexpected condition. See Chapter 2, “Trace logging,”
on page 3 for more information.
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Problem classification
The following types of problems might occur with the IBM Tivoli Monitoring: Windows OS Agent:
v Installation and configuration
v General usage and operation
v Display of monitoring data
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Chapter 2. Trace logging

Trace logs capture information about the operating environment when component software fails to
operate as intended. The principal log type is the RAS (Reliability, Availability, and Serviceability) trace
log. These logs are in the English language only. The RAS trace log mechanism is available for all
components of IBM Tivoli Monitoring. Most logs are located in a logs subdirectory on the host computer.

IBM Software Support uses the information captured by trace logging to trace a problem to its source or
to determine why an error occurred. The default configuration for trace logging, such as whether trace
logging is enabled or disabled and trace level, depends on the source of the trace logging. Trace logging
is always enabled.

Note: The documentation refers to the RAS facility in IBM Tivoli Monitoring as "RAS1".

To learn how to configure and use trace logging, see the following topics:
v “Principal trace log files” on page 4
v “Examples: using trace logs” on page 5
v “Setting RAS trace parameters” on page 6

Overview of log file management
Table 2 on page 4 provides the names, locations, and descriptions of RAS1 log files. The log file names
adhere to the following naming convention:

hostname_product_program_timestamp-nn.log

where:
v hostname is the host name of the machine on which the monitoring component is running.
v product is the two-character product code. For Monitoring Agent for Windows OS, the product code is

nt.
v program is the name of the program being run.
v timestamp is an 8-character hexadecimal timestamp representing the time at which the program started.
v nn is a rolling log suffix. See “Examples of trace logging” for details of log rolling.

Examples of trace logging
For example, if a Microsoft Windows monitoring agent is running on computer "server01", the RAS log
file for the Monitoring Agent for Windows OS might be named as follows:
server01_nt_kntcma_437fc59-01.log

For long-running programs, the nn suffix is used to maintain a short history of log files for that startup of
the program. For example, the kntcma program might have a series of log files as follows:
server01_nt_kntcma_437fc59-01.log
server01_nt_kntcma_437fc59-02.log
server01_nt_kntcma_437fc59-03.log

As the program runs, the first log (nn=01) is preserved because it contains program startup information.
The remaining logs "roll." In other words, when the set of numbered logs reach a maximum size, the
remaining logs are overwritten in sequence.

© Copyright IBM Corp. 1994, 2013 3



Each time a program is started, a new timestamp is assigned to maintain a short program history. For
example, if the Monitoring Agent for Windows OS is started twice, it might have log files as follows:
server01_nt_kntcma_437fc59-01.log
server01_nt_kntcma_437fc59-02.log
server01_nt_kntcma_437fc59-03.log

server01_nt_kntcma_537fc59-01.log
server01_nt_kntcma_537fc59-02.log
server01_nt_kntcma_537fc59-03.log

Each program that is started has its own log file. For example, the Monitoring Agent for Windows OS
would have agent logs in this format:
server01_nt_kntcma_437fc59-01.log

Other logs, such as logs for collector processes and Take Action commands, have a similar syntax as in
the following example:
server01_nt_kntpgm_447fc59-01.log

where kntpgm is the program name.

Note: When you communicate with IBM Software Support, you must capture and send the RAS1 log
that matches any problem occurrence that you report.

Principal trace log files

Table 2 contains locations, file names, and descriptions of trace logs that can help determine the source of
problems with agents.

Table 2. Trace log files for troubleshooting agents

System where log
is located

File name and path Description

On the computer
that hosts the
monitoring agent

See Definitions of
variables for
descriptions of the
variables in the
file names in
column two.

The RAS1 log files are named
hostname_nt_program_timestamp-nn.log and are
located in the install_dir\tmaitm6_x64\logs path
if you have installed a 64-bit agent, or in the
install_dir\tmaitm6\logs path if you have
installed a 32-bit agent.
Note: File names for RAS1 logs include a
hexadecimal timestamp.

Traces activity of the monitoring agent.
Note: Other logs, such as logs for Take
Action commands (if available), have a
similar syntax and are located in this
directory path.

The *.LG0 file is located in the
install_dir\tmaitm6_x64\logs path if you have
installed a 64-bit agent, or in the
install_dir\tmaitm6\logs path if you have
installed a 32-bit agent.

A new version of this file is generated
every time the agent is restarted. IBM Tivoli
Monitoring generates one backup copy of
the *.LG0 file with the tag .LG1. View .LG0
to learn the following details regarding the
current monitoring session:
v Status of connectivity with the

monitoring server.
v Situations that were running.
v The success or failure status of Take

Action commands.
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Table 2. Trace log files for troubleshooting agents (continued)

System where log
is located

File name and path Description

On the Tivoli
Enterprise
Monitoring Server

See Definitions of
variables for
descriptions of the
variables in the
file names in
column two.

On UNIX: The candle_installation.log file in the
install_dir/logs path.

On Windows: The file in the install_dir\
InstallITM path.

Provides details about products that are
installed.
Note: Trace logging is enabled by default.
A configuration step is not required to
enable this tracing.

The Warehouse_Configuration.log file is located
in the following path on Windows: install_dir\
InstallITM.

Provides details about the configuration of
data warehousing for historical reporting.

The RAS1 log file is named
hostname_ms_timestamp-nn.log and is located in
the following path:

v On Windows: install_dir\logs

v On UNIX: install_dir/logs

Note: File names for RAS1 logs include a
hexadecimal timestamp

Also on UNIX, a log with a decimal timestamp is
provided: hostname_ms_timestamp.log and
hostname_ms_timestamp.pidnnnnn in the
install_dir/logs path, where nnnnn is the
process ID number.

Traces activity on the monitoring server.

On the Tivoli
Enterprise Portal
Server

See Definitions of
variables for
descriptions of the
variables in the
file names in
column two.

The RAS1 log file is named
hostname_cq_timestamp-nn.log and is located in
the following path:

v On Windows: install_dir\logs

Note: File names for RAS1 logs include a
hexadecimal timestamp

Traces activity on the portal server.

The TEPS_ODBC.log file is located in the following
path on Windows: install_dir\InstallITM.

When you enable historical reporting, this
log file traces the status of the warehouse
proxy agent.

Definitions of variables for RAS1 logs:
v hostname is the host name of the machine on which the agent is running.
v install_dir represents the directory path where you installed the IBM Tivoli Monitoring component. install_dir can

represent a path on the computer that hosts the monitoring server, the monitoring agent, or the portal server.
v product is the two-character product code. For Monitoring Agent for Windows OS, the product code is nt.
v program is the name of the program being run.
v timestamp is an eight-character hexadecimal timestamp representing the time at which the program started.
v nn is a rolling log suffix. See “Examples of trace logging” on page 3 for details of log rolling.

See the IBM Tivoli Monitoring Installation and Setup Guide for more information on the complete set of
trace logs that are maintained on the monitoring server.

Examples: using trace logs
Typically IBM Software Support applies specialized knowledge to analyze trace logs to determine the
source of problems. However, you can open trace logs in a text editor such as wordpad to learn some
basic facts about your IBM Tivoli Monitoring environment. You can use the dir command to list the log
files in the install_dir/logs directories, sorted by time they were last updated.
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Example one
This excerpt shows the typical log for a failed connection between a monitoring agent and a
monitoring server with the host name server1a:

(Thursday, August 11, 2005, 08:21:30-{94C}kdcl0cl.c,105,"KDCL0_ClientLookup") status=1c020006,
"location server unavailable", ncs/KDC1_STC_SERVER_UNAVAILABLE

(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1157,"LookupProxy") Unable to connect to
broker at ip.pipe:: status=0, "success", ncs/KDC1_STC_OK

(Thursday, August 11, 2005, 08:21:35-{94C}kraarreg.cpp,1402,"FindProxyUsingLocalLookup") Unable
to find running CMS on CT_CMSLIST <IP.PIPE:#server1a>

Example two
The following excerpts from the trace log for the monitoring server show the status of an agent,
identified here as "Remote node." The name of the computer where the agent is running is
SERVER5B:

(42C039F9.0000-6A4:kpxreqhb.cpp,649,"HeartbeatInserter") Remote node Primary:SERVER5B:NT is ON-LINE.
. . .
(42C3079B.0000-6A4:kpxreqhb.cpp,644,"HeartbeatInserter") Remote node Primary:SERVER5B:NT is OFF-LINE.

Key points regarding the preceding excerpt:
v The monitoring server appends the NT product code to the server name to form a unique

name (Primary:SERVER5B:KNT) for this instance of Monitoring Agent for Windows OS. This
unique name enables you to distinguish multiple monitoring products that might be running
on SERVER5B.

v The log shows when the agent started (ON-LINE) and later stopped (OFF-LINE) in the
environment.

v For the sake of brevity an ellipsis (...) represents the series of trace log entries that were
generated while the agent was running.

v Between the ON-LINE and OFF-LINE log entries, the agent was communicating with the
monitoring server.

v The ON-LINE and OFF-LINE log entries are always available in the trace log. All trace levels
that are described in “Setting RAS trace parameters” provide these entries.

On Windows, you can use the following alternate method to view trace logs:
1. In the Windows Start menu, choose Program Files > IBM Tivoli® Monitoring > Manage Tivoli

Monitoring Service. The Manage Tivoli Enterprise Monitoring Services window is displayed.
2. Right-click a component and select Advanced > View Trace Log in the pop-up menu. The program

displays the Select Log File window that lists the RAS1 logs for the monitoring agent.
3. Select a log file from the list and click OK. You can also use this viewer to access remote logs.

Note: The viewer converts timestamps in the logs to a readable format.

Setting RAS trace parameters
Objective

Pinpoint a problem by setting detailed tracing of individual components of the monitoring agent and
modules.

Background Information

Monitoring Agent for Windows OS uses RAS1 tracing and generates the logs described in Table 2 on
page 4. The default RAS1 trace level is ERROR.

RAS1 tracing has control parameters to manage to the size and number of RAS1 logs. Use the procedure
described in this topic to set the parameters.
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Note: The KBB_RAS1_LOG parameter also provides for the specification of the log file directory, log file
name, and the inventory control file directory and name. Do not modify these values or log information
can be lost.

Before you begin

See “Overview of log file management” on page 3 to ensure that you understand log rolling and can
reference the correct log files when you managing log file generation.

After you finish

Monitor the size of the logs directory. Default behavior can generate a total of 45 to 60 MB for each agent
that is running on a computer. For example, each database instance that you monitor could generate 45 to
60 MB of log data. See the “Procedure” topic to learn how to adjust file size and numbers of log files to
prevent logging activity from occupying too much disk space.

Regularly prune log files other than the RAS1 log files in the logs directory. Unlike the RAS1 log files
which are pruned automatically, other log types can grow indefinitely, for example, the logs in Table 2 on
page 4 that include a process ID number (PID).

Consider using collector trace logs (described in Table 2 on page 4) as an additional source of
troubleshooting information.

Procedure

Specify RAS1 trace options in the KNTENV file. You also need specify tracing options for kcawd in the
environment file, KCAENV. You can manually edit the KNTENV configuration file to set trace logging:
1. Open the trace options file: install_dir\tmaitm6_x64\KNTENV if you have installed a 64-bit agent or

install_dir\tmaitm6\KNTENV if you have installed a 32-bit agent.
2. Edit the line that begins with KBB_RAS1= to set trace logging preferences.

For example, if you want detailed trace logging, set the Maximum Tracing option:
KBB_RAS1=ERROR (UNIT:knt ALL) (UNIT:kra ALL)

3. Edit the line that begins with KBB_RAS1_LOG= to manage the generation of log files:
v Edit the following parameters to adjust the number of rolling log files and their size.

– MAXFILES: the total number of files that are to be kept for all startups of a given program.
Once this value is exceeded, the oldest log files are discarded. Default value is 9.

– LIMIT: the maximum size, in megabytes (MB) of a RAS1 log file. Default value is 5.
v IBM Software Support might guide you to modify the following parameters:

– COUNT: the number of log files to keep in the rolling cycle of one program startup. Default
value is 3.

– PRESERVE: the number of files that are not to be reused in the rolling cycle of one program
startup. Default value is 1.

Note: The KBB_RAS1_LOG parameter also provides for the specification of the log file directory, log
file name, and the inventory control file directory and name. Do not modify these values or log
information can be lost.

4. Restart the monitoring agent so that your changes take effect.

(Windows only) Alternate method to edit trace logging parameters:

1. Open the Manage Tivoli Enterprise Monitoring Services window.
2. Right-click the icon of the monitoring agent whose logging you want to modify.
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3. Select Advanced > Edit Trace Parms. The Tivoli Enterprise Monitoring Server Trace Parameters
window is displayed.

4. Select a new trace setting in the pull-down menu in the Enter RAS1 Filters field or type a valid
string.
The selections are as follows:
v No error tracing. KBB_RAS1=-none-
v General error tracing. KBB_RAS1=ERROR
v Intensive error tracing. KBB_RAS1=ERROR (UNIT:knt ALL) (UNIT:knz ALL) (UNIT:knl ALL)

v Maximum error tracing. KBB_RAS1=ERROR (UNIT:knt ALL) (UNIT:kra ALL)

Note: As this example shows, you can set multiple RAS tracing options in a single statement.

Note: For more detailed tracing, you can substitute DETAIL for ERROR in the above selections.
5. Modify the value for "Maximum Log Size Per File (MB)" to change the log file size (changes LIMIT

value).
6. Modify the value for "Maximum Number of Log Files Per Session" to change the number of logs files

per startup of a program (changes COUNT value).
7. Modify the value for "Maximum Number of Log Files Total" to change the number of logs files for all

startups of a program (changes MAXFILES value).
8. (Optional) Click Y (Yes) in the KDC_DEBUG Setting menu to log information that can help you

diagnose communications and connectivity problems between the monitoring agent and the
monitoring server.

Note: The KDC_DEBUG setting and the Maximum error tracing setting can generate a large amount
of trace logging. Use them only temporarily, while you are troubleshooting problems. Otherwise, the
logs can occupy excessive amounts of hard disk space.

9. Click OK. You see a message reporting a restart of the monitoring agent so that your changes take
effect.
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Chapter 3. Problems and workarounds

See the IBM Tivoli Monitoring Troubleshooting Guide for general troubleshooting information. This
publication provides agent-specific troubleshooting information.

The following topics provide symptoms and workarounds for problems that might occur with Monitoring
Agent for Windows OS:
v “Installation and configuration troubleshooting”
v “Agent troubleshooting” on page 12
v “Tivoli Enterprise Portal troubleshooting” on page 16
v “Troubleshooting for remote deployment” on page 16
v “Workspace troubleshooting” on page 17
v “Tivoli Common Reporting troubleshooting” on page 18
v “Situation troubleshooting” on page 19

Installation and configuration troubleshooting
Table 3 shows solutions for installation and configuration problems.

Table 4 on page 11 shows solutions for uninstallation problems.

Table 3. Problems and solutions for installation and configuration

Problem Solution

Unable to install the monitoring agent on a
Windows 2008 64-bit Enterprise Edition
system.

Confirm if you are at the supported level.

Increase the tracing on the Windows OS agent. Set maximum
tracing on the agent. For instructions, see “Setting RAS trace
parameters” on page 6.

A problem can arise when you install and
configure a new monitoring agent to a
computer where other agents are running as
described in this example:

v Agents are running on computer and
communicating with a Tivoli Enterprise
Monitoring Server, called TEMS1.

v You install a new agent on the same
computer and you want this agent to
communicate with a different monitoring
server, called TEMS2.

v When you configure the new agent to
communicate with TEMS2, all the existing
agents are re-configured to communicate
with TEMS2.

You must reconfigure the previously existing agents to restore their
communication connection with TEMS1. For example, you can
right-click the row for a specific agent in the Manage Tivoli
Enterprise Monitoring Services, and select Reconfigure. See the IBM
Tivoli Monitoring Installation and Setup Guide for more information on
reconfiguration.

Error Message - Could not open DNS registry
key

This message is informational only. No action is required. The
Windows agent reports the fact that it could not find a registry
entry for the DNS Server Event Log. This means that the DNS
Server is not installed.
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Table 3. Problems and solutions for installation and configuration (continued)

Problem Solution

The following problems occur in workspace
views:

v The Monitored Logs workspace shows a
record count of zero (0).

v The Event Logs workspace shows no
records.

Windows security logging is not turned on by default. Normally, no
data is collected in the security log unless the Windows
administrator turns it on. The Record Count = 0 data value that the
monitoring agent returns in the Windows monitored logs report
confirms that security logging is not turned on.

Diagnosing problems with product browse
settings.

When you have problems with browse settings, perform the
following steps:

1. Click on Start > Programs > IBM Tivoli Monitoring > Manage
Tivoli Enterprise Monitoring Services. The Manage Tivoli
Enterprise Monitoring Services is displayed.

2. Right-click the Windows agent and select Browse Settings. A
text window is displayed.

3. Click Save As and save the information in the text file. If
requested, you can forward this file to IBM Software Support for
analysis.

A message similar to "Unable to find running
CMS on CT_CMSLIST" in the log file is
displayed.

If a message similar to "Unable to find running CMS on
CT_CMSLIST" is displayed in the Log file, the agent is not able to
connect to the monitoring server. Confirm the following points:

v Do multiple network interface cards (NICs) exist on the system?

v If multiple NICs exist on the system, find out which one is
configured for the monitoring server. Ensure that you specify the
correct host name and port settings for communication in the IBM
Tivoli Monitoring environment.

The system is experiencing high CPU usage
after you install or configure Monitoring
Agent for Windows OS.

Agent process: View the memory usage of the KNTCMA process. If
CPU usage seems to be excessive, recycle the monitoring agent.

Network Cards: The network card configurations can decrease the
performance of a system. Each of the stream of packets that a
network card receives (assuming it is a broadcast or destined for the
under-performing system) must generate a CPU interrupt and
transfer the data through the I/O bus. If the network card in
question is a bus-mastering card, work can be off-loaded and a data
transfer between memory and the network card can continue
without using CPU processing power. Bus-mastering cards are
generally 32-bit and are based on PCI or EISA bus architectures.

You successfully migrate an OMEGAMON®

monitoring agent to IBM Tivoli Monitoring,
Version 6.2.0 or later. However, when you
configure historical data collection, you see an
error message that includes, Attribute name
may be invalid, or attribute file not
installed for warehouse agent.

Install the agent's application support files on the Tivoli Enterprise
Monitoring Server, using the following steps:

1. Open the Manage Tivoli Enterprise Monitoring Services window.

2. Right-click the name of the monitoring server.

3. Select Advanced > Add TEMS Application Support in the
pop-up menu. Add application support if any for any agent that
is missing from the list. See in IBM Tivoli Monitoring Installation
and Setup Guide for more information on adding application
support.

Ensure that the agent's application support files are pushed to the
system that houses the Warehouse Proxy Agent. The Warehouse
Proxy must be able to access the short attribute names for tables
and columns. That way, if the longer versions of these names exceed
the limits of the Warehouse database, the shorter names can be
substituted.
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Table 4. General problems and solutions for uninstallation

Problem Solution

On Windows, uninstallation of IBM
Tivoli Monitoring fails to uninstall
the entire environment.

Be sure that you follow the general uninstallation process described in the
IBM Tivoli Monitoring Installation and Setup Guide:

1. Uninstall monitoring agents first, as in the following examples:

v Uninstall a single monitoring agent for a specific database.

—OR—

v Uninstall all instances of a monitoring product, such as IBM Tivoli
Monitoring for Databases.

2. Uninstall IBM Tivoli Monitoring.

See the IBM Tivoli Monitoring Troubleshooting Guide and the topic on
installation problems for more information on how to remove the entire
environment.

The way to remove inactive
managed systems (systems whose
status is OFFLINE) from the
Enterprise navigation tree in the
portal is not obvious.

When you want to remove a managed system from the navigation tree,
complete the following steps:

1. Click Enterprise in the navigation tree.

2. Right-click Workspace -> Managed System Status.

3. Right-click the offline managed system and select Clear offline entry.

Unique names for monitoring components
You must decide how to name the monitoring agents. This name is intended to uniquely identify that
monitoring agent. The agent's default name is composed of three qualifiers:
v Optional instance name
v Machine network host name
v Agent product node type

An agent name truncation problem can occur when the network domain name is included in the network
host name portion of the agent name. For example, instead of just the host name myhost1 being used, the
resulting host name might be myhost1.acme.north.prod.com. Inclusion of the network domain name
causes the agent name in the example above to expand to SERVER1:myhost1.acme.north.prod.com:KXX.
This resulting name is 39 characters long. It is truncated to 32 characters resulting in the name
SERVER1:myhost1.acme.north.prod.

In general, create names that are short but meaningful within your environment. Use the following
guidelines:
v Each name must be unique. One name cannot match another monitoring agent name exactly.
v Each name must begin with an alpha character.
v Do not use blanks or special characters, including $, #, and @.
v Each name must be between 2 and 32 characters in length.
v Monitoring agent naming is case-sensitive on all operating systems.

Create the names by completing the following steps:
1. Open the configuration file for the monitoring agent, which is located in install_dir\tmaitm6_x64\

Kproduct_codeCMA.INI if you have installed a 64-bit agent or install_dir\tmaitm6\
Kproduct_codeCMA.INI if you have installed a 32-bit agent. For example, the product code for the
Monitoring Agent for Windows OS is NT and the file name is KNTCMA.INI.

2. Find the line the begins with CTIRA_HOSTNAME=.
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3. Type a new name for host name that is a unique, shorter name for the host computer. The final
concatenated name including the subsystem name, new host name, and NT, cannot be longer than 32
characters.

Note: You must ensure that the resulting name is unique with respect to any existing monitoring
component that was previously registered with the Tivoli Enterprise Monitoring Server.

4. Save the file.
5. Restart the agent.
6. If you do not find the files mentioned in Step 1, perform the workarounds listed in the next

paragraph.

If you do not find the files mentioned in the preceding steps, perform the following workarounds:
1. Change CTIRA_HOSTNAME environment variable in the configuration file of the monitoring agent.

v Find the KNTENV file in the same path mentioned in the preceding row.
2. If you cannot find the CTIRA_HOSTNAME environment variable, you must add it to the

configuration file of the monitoring agent:
v On Windows: Use the Advanced > Edit Variables option.

3. Some monitoring agents (for example, the monitoring agent for MQ Series) do not reference the
CTIRA_HOSTNAME environment variable to generate component names. Check the documentation
for the monitoring agent that you are using for information on name generation. If necessary, contact
IBM Software Support.

Agent troubleshooting
Table 5 provides agent-specific troubleshooting information. See the IBM Tivoli Monitoring Troubleshooting
Guide for general troubleshooting information.

Table 5. Agent problems and solutions

Problem Solution

The monitoring agent stops
with the following error:

Unable to allocate
2147483642 bytes of
memory.
Agent is terminating...

Delete the TMAITM6\logs\khdexp.cfg file then restart agent. Observe if your agent still
terminates and sends the memory allocation error.

If after deleting the khdexp.cfg file the agent still terminates with the same memory
error, remove all the entries in TMAITM6\logs then restart the agent. You can move
them to a temporary directory if you do not want to delete them. After removing all
entries in TMAITM6\logs and restarting the agent, observe if your agent still sends the
memory allocation error.
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Table 5. Agent problems and solutions (continued)

Problem Solution

A configured and running
instance of the monitoring
agent is not displayed in the
Tivoli Enterprise Portal, but
other instances of the
monitoring agent on the
same system do appear in
the portal.

Tivoli Monitoring products use Remote Procedure Call (RPC) to define and control
product behavior. RPC is the mechanism that allows a client process to make a
subroutine call (such as GetTimeOfDay or ShutdownServer) to a server process
somewhere in the network. Tivoli processes can be configured to use TCP/UDP,
TCP/IP, SNA, and SSL as the desired protocol (or delivery mechanism) for RPCs.

"IP.PIPE" is the name given to Tivoli TCP/IP protocol for RPCs. The RPCs are
socket-based operations that use TCP/IP ports to form socket addresses. IP.PIPE
implements virtual sockets and multiplexes all virtual socket traffic across a single
physical TCP/IP port (visible from the netstat command).

A Tivoli process derives the physical port for IP.PIPE communications based on the
configured, well-known port for the HUB Tivoli Enterprise Monitoring Server. (This
well-known port or BASE_PORT is configured using the 'PORT:' keyword on the
KDC_FAMILIES / KDE_TRANSPORT environment variable and defaults to '1918'.)

The physical port allocation method is defined as (BASE_PORT + 4096*N) where N=0
for a Tivoli Enterprise Monitoring Server process and N={1, 2, ..., 15} for a non-Tivoli
Enterprise Monitoring Server. Two architectural limits result as a consequence of the
physical port allocation method:

v No more than one Tivoli Enterprise Monitoring Server reporting to a specific Tivoli
Enterprise Monitoring Server HUB can be active on a system image.

v No more that 15 IP.PIPE processes can be active on a single system image.

A single system image can support any number of Tivoli Enterprise Monitoring
Server processes (address spaces) provided that each Tivoli Enterprise Monitoring
Server on that image reports to a different HUB. By definition, there is one Tivoli
Enterprise Monitoring Server HUB per monitoring Enterprise, so this architecture
limit has been simplified to one Tivoli Enterprise Monitoring Server per system
image.

No more that 15 IP.PIPE processes or address spaces can be active on a single system
image. With the first limit expressed above, this second limitation refers specifically to
Tivoli Enterprise Monitoring Agent processes: no more that 15 agents per system
image.

This limitation can be circumvented (at current maintenance levels, IBM Tivoli
Monitoring V6.1 Fix Pack 4 and later) if the Tivoli Enterprise Monitoring Agent
process is configured to use EPHEMERAL IP.PIPE. (This is IP.PIPE configured with
the 'EPHEMERAL:Y' keyword in the KDC_FAMILIES / KDE_TRANSPORT
environment variable). There is no limitation to the number of ephemeral IP.PIPE
connections per system image. If ephemeral endpoints are used, the Warehouse Proxy
Agent is accessible from the Tivoli Enterprise Monitoring Server associated with the
agents using ephemeral connections either by running the Warehouse Proxy Agent on
the same computer or by using the Firewall Gateway feature. (The Firewall Gateway
feature relays the Warehouse Proxy Agent connection from the Tivoli Enterprise
Monitoring Server computer to the Warehouse Proxy Agent computer if the
Warehouse Proxy Agent cannot coexist on the same computer.)
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Table 5. Agent problems and solutions (continued)

Problem Solution

The agent goes off-line
when collecting the network
port attribute due to reverse
DNS look-up time-out.

This agent can hang when querying network ports information and the DNS reverse
lookup is disabled. Several errors similar to the following will be logged:

(4A7BDB8F.0000-1B90:knt67agt.cpp,243,"TakeSample") gethostbyaddr
error <11004> for IP address
error <11004> for IP address

(4A7BDB94.0000-1B90:knt67agt.cpp,243,"TakeSample") gethostbyaddr
error <11004> for IP address
error <11004> for IP address

The agent appears to be off-line in the Tivoli Enterprise Portal, and does not report
any data for any workspace. The environment variable
REVERSE_LOOKUP_ACCEPTED_FAILURES that can be specified in the
configuration file allows you to set the number of accepted failures in the reverse
lookup. This action can reduce the hang time.

The process application
components are available,
but the Availability status
shows
PROCESS_DATA_NOT_
AVAILABLE.

This problem occurs because the PerfProc performance object is disabled. When this
condition exists, IBM Tivoli Monitoring cannot collect performance data for this
process. Do the following to confirm that this problem exists and resolve it: Choose
Run in the Windows Start menu. Type perfmon.exe in the Open field of the Run
window. The Performance window is displayed. Click the plus sign (+) in the tool bar
located above the right pane. The Add Counters window is displayed. Look for
Process in the Performance object pull-down menu. Perform one of the following
actions: If you see Process in the pull-down menu, the PerfProc performance object is
enabled and the problem is coming from a different source. You might need to contact
IBM Software Support. If you do not see Process in the pull-down menu, use the
Microsoft utility from the following Web site to enable the PerfProc performance
object:

http://blogs.technet.com/mscom/archive/2008/12/18/the-mystery-of-the-missing
-process-performance-counter-in-perfmon.aspx

The Process performance object becomes visible in the Performance object pull-down
menu of the Add Counters windows, and IBM Tivoli Monitoring is able to detect
Availability data. Restart the monitoring agent.

The CPU of the Monitoring
Agent for Windows OS is
high

The PerfProc service is typically the one responsible for high CPU. Others, like TCPIP,
might also need to be disabled. Using the exctrlst.exe that you can download from the
Microsoft site, you can disable the PerfProc and TCPIP services. Run the exctrlst.exe
command to bring up the Extensible Counter List, where all of the counters are listed.
You can deselect the Performance Counters Enabled box while highlighting PerfProc.
Click Refresh to save the change. The same method can be used to disable the TCPIP
counter.

If these two services are stopped, Tivoli Enterprise Portal workspaces or situations
based on Process and Network attribute groups will no longer function.

The Long Queue Name is
not matched with the row
data collected from
perfmon.

To allow the Long Queue Name to be matched with the row data collected from
perfmon (all the remaining attributes for each MSMQ Queue) the first 63 bytes
(characters) of the Queue Name must be unique. This is the only way that the queue
name can be matched with the additional metrics that come back from perfmon (the
source for the remaining attributes of the queue instance).

When you edit the
configuration for an existing
monitoring agent, the values
displayed are not correct.

The original configuration settings might include non-ASCII characters. These values
were stored incorrectly and result in the incorrect display. Enter new values using
only ASCII characters.

Attributes do not allow
non-ASCII input in the
situation editor.

None. Any attribute that does not include "(Unicode)" might support only ASCII
characters. For example "Attribute (Unicode)" will support unicode but "Attribute"
without "(Unicode)" might only support ASCII characters.

14 IBM Tivoli Monitoring: Windows OS Agent Troubleshooting Guide



Table 5. Agent problems and solutions (continued)

Problem Solution

The Windows Agent
accesses the root\cimv2
WMI namespace to collect
its WMI data. The Security
(Access Permissions) for
allowing the agent to access
these namespaces need to
have Enable, Execute
Methods, and Provider
Write permissions for the
Everyone account.

1. Click Start -> Run.

2. Type Wmimgmt.msc and click OK.

3. Right-click Wmi Control and choose properties.

4. Ensure that it says successfully connected in the General tab and then choose the
Security tab.

5. Select Root folder and then click Security at the bottom of the screen.

6. Highlight Everyone and then ensure that the 'Enable Account', 'Execute Methods',
'Provider Write' option is Allowed. If it is not, then choose this option.

7. Highlight Local Service and then ensure that the 'Provider Write' option is
Allowed. If it is not, then choose this option.

8. Click OK.

9. Reboot the server once.

No performance data is
displayed in workspace
views, no data is available
for situations, and no data is
available for historical
logging.

When the Windows operating system detects a problem in one of its extensible
performance monitoring DLL files, it marks the DLL as "disabled." Any DLL that is
disabled cannot provide performance data through the Windows Performance
Monitor interfaces (Perfmon or Performance Monitor APIs). This prevents IBM Tivoli
Monitoring agents from gathering data supplied by the disabled DLL. For more
information, see Microsoft Support Knowledge Base article 248993 at the following
Web address: http://support.microsoft.com/default.aspx?scid=kb;EN-US;248993

Follow the Resolution instructions provided in this article (248993) to re-enable any
performance monitoring extension DLL files disabled by Windows. Then, restart the
monitoring agent.

Log data accumulates too
rapidly.

Check the RAS trace option settings, which are described in “Setting RAS trace
parameters” on page 6. The trace options settings that you can set on the KBB_RAS1=
and KDC_DEBUG= lines potentially generate large amounts of data.

The system runs out of
memory while the agent is
collecting data.

Ensure that you have installed the newest Service Packs for the Microsoft .NET
Framework. Depending on the level of the Windows operating system that you are
using, the required Service Pack is as follows:

v .NET Framework 1.0 SP3

—OR—

v .NET Framework 1.1 SP1

Attributes Date Time Last
Modified and Date Time
Created in the File Change
attribute group seem to
have their positions
switched in the situation
editor when specifying a
time comparison between
these attributes, using the
Compare time to a + or -
delta function.

This can occur when creating a new situation that uses the attributes of Date Time
Last Modified and Date Time Created in the File Change attribute group. If you then
select the function Compare time to a + or - delta, it does not show the time attribute
that is currently selected.

This is working as designed. 'Compare time to a + or - delta' is to compare the
current selected time attribute with other available time attributes with a delta, not
with the selected time attribute itself. When you select Date Time Last Modified and
Date Time Created, the "Time Attribute for Comparison" shows the available time
attributes and it seemed as if the attribute names were switched.
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Tivoli Enterprise Portal troubleshooting
Table 6 lists problems that might occur with the Tivoli Enterprise Portal.

Table 6. Tivoli Enterprise Portal problems and solutions

Problem Solution

Historical data collection is
unavailable because of
incorrect queries in the Tivoli
Enterprise Portal.

The column, Sort By, Group By, and First/Last functions are not compatible with
the historical data collection feature. Use of these advanced functions will make a
query ineligible for historical data collection.

Even if data collection has been started, you cannot use the time span feature if the
query for the chart or table includes any column functions or advanced query
options (Sort By, Group By, First / Last).

To ensure support of historical data collection, do not use the Sort By, Group By, or
First/Last functions in your queries.

See the IBM Tivoli Monitoring Administrator's Guide the Tivoli Enterprise Portal
online Help for information on the Historical Data Collection function.

When you use a long process
name in the situation, the
process name is truncated.

Truncation of process names in the portal display is the expected behavior. 64 bytes
is the maximum name length.

Data is missing from the
physical and logical disk
views in the Tivoli Enterprise
Portal.

Open a DOS Window, issue "diskperf -y" and then reboot the Windows system.

Troubleshooting for remote deployment
Table 7 lists problems that might occur with remote deployment and removal of agent software Agent
Remote Deploy.

Table 7. Remote deployment problems and solutions

Problem Solution

While you are using the remote deployment feature
to install Monitoring Agent for Windows OS, an
empty command window is displayed on the target
computer. This problem occurs when the target of
remote deployment is a Windows computer. (See the
IBM Tivoli Monitoring Installation and Setup Guide for
more information on the remote deployment
feature.)

Do not close or modify this window. It is part of the
installation process and will be dismissed automatically.

The removal of a monitoring agent fails when you
use the remote removal process in the Tivoli
Enterprise Portal desktop or browser.

This problem might happen when you attempt the remote
removal process immediately after you have restarted the
Tivoli Enterprise Monitoring Server. You must allow time for
the monitoring agent to refresh its connection with the Tivoli
Enterprise Monitoring Server before you begin the remote
removal process.

The attempt to install an additional OS agent on the
same machine fails.

On Windows, IBM Tivoli Monitoring does not support more
than one OS agent installation on the same machine. You can
not use different directories to install more than one OS agent
on the same Windows machine.
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Workspace troubleshooting
Table 8 shows problems that might occur with workspaces.

Table 8. Workspace problems and solutions

Problem Solution

You see the following message: KFWITM083W
Default link is disabled for the selected
object; please verify link and link anchor
definitions.

You see this message because some links do not have default
workspaces. Right-click the link to access a list of workspaces to
select.

The name of the attribute does not display in a
bar chart or graph view.

When a chart or graph view that includes the attribute is scaled
to a small size, a blank space is displayed instead of a truncated
name. To see the name of the attribute, expand the view of the
chart until there is sufficient space to display all characters of the
attribute's name.

At the bottom of the views for the Historical
Summarized Availability workspace, the
Historical Summarized Capacity workspace, and
the Historical Summarized Performance
workspace, you see the following error:

KFWITM220E Request failed during execution

Configure historical collection for these workspaces.

You start collection of historical data but the data
cannot be seen.

Managing options for historical data collection:

v Basic historical data collection populates the Warehouse with
raw data. This type of data collection is turned off by default.
See the IBM Tivoli Monitoring Windows OS Agent Installation
and Configuration Guide for information on managing this
feature including how to set the interval at which data is
collected. By setting a more frequent interval for data
collection you reduce the load on the system incurred every
time data is uploaded.

v You use the Summarization and Pruning monitoring agent to
summarize available raw data and store the summarizations in
the database. Be aware that summarized data is not displayed
until the Summarization and Pruning monitoring agent begins
collecting the data. By default, this agent begins collection at 2
AM daily. At that point, data is visible in the workspace view.
See the IBM Tivoli Monitoring Administrator's Guide to learn
how to modify the default collection settings.

Regular (non-historical) monitoring data fails to
be displayed.

Check the formation of the queries you use to gather capture
data. For example, look for invalid SQL statements.

The Event Log workspace does not show
complete event logs.

To maintain good system response times, the Event Log agent
limits collection of events to 500 for each query . You can use the
following procedure to control which 500 events are retrieved
from the event log:

1. Click the Historical icon (the clock symbol in the upper left
of the workspace).

2. Select the time span.

3. Reduce the amount of data that you retrieve, or restrict the
time span. For example, you might capture the last 24 hours
or you might select Custom and choose a shorter time
interval.
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Table 8. Workspace problems and solutions (continued)

Problem Solution

The following problems occur in workspace
views:

v The Monitored Logs workspace shows a record
count of zero (0).

v The Event Logs workspace shows no records.

Windows security logging is not turned on by default. Normally,
no data is collected in the security log unless the Windows
administrator turns it on. The Record Count = 0 data value that
the monitoring agent returns in the Windows monitored logs
report confirms that security logging is not turned on.

There is no data for a service-type workspace. Ensure that the service is running.

The Agents Management Services workspace
provides the wrong IP loopback address in the IP
Address column of the Agents' Runtime Status
view.

Be aware that the IP loopback address in the Agents' Runtime
Status view is for IPv4, instead of IPv6, even in IPv6
environments.

Tivoli Common Reporting troubleshooting
Table 9 lists general problems that might occur with Tivoli Common Reporting.

Table 9. Tivoli Common Reporting problems and solutions

Problem Solution

Reports that are based on CCC Logs attributes,
such as the Top Situations By Status report and
the Situations History report, rely on raw data
from the Status_History table in the Tivoli Data
Warehouse. To ensure accurate and complete
reports, you might need to confirm historical
collection of CCC Logs data.

The Status_History table is populated by collecting historical
data from the monitoring server for CCC Logs data after you
select the Situation Status Log attribute group. Historical
collection of CCC Logs data can be confirmed by ensuring that
the UADVISOR situation for O4SRV_TSITSTSH appears in the
TEMS messages file.

On Windows, the kdsmain.msg file in the: %CANDLE_HOME%\CMS\
path.

On UNIX and Linux, the <hostname>_ms_<Timestamp>.log file in
the <InstallDirectory>/logs/ path.

Example entries in the TEMS messages log showing the
O4SRV_TSITSTSH attribute gathered in a UADVISOR situation
include:

v KO46256 Situation definition UADVISOR_O4SRV_TSITSTSH
created by *ENTERPRISE.

v KO41047 Situation UADVISOR_O4SRV_TSITSTSH distribution
HUB_TEMS1 added.

v KO41046 Monitoring for enterprise situation
UADVISOR_O4SRV_TSITSTSH started.

After historical data is collected and exported and following the
next warehousing interval of the TDW database, the
Status_History table will be populated with data required to run
the TCR reports using CCC Logs.
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Situation troubleshooting
Table 10 lists problems that might occur with specific situations.

Table 10. Specific situation problems and solutions

Problem Solution

There is a high CPU load while any of
the following 3 situations are turned on:

v NT_Server_Error

v NT_Invalid_Login

v NT_Event_Log_Full

In this case, an event log is receiving a
large number of events, and the
processing of these events for the
enabled situations causes a high CPU
load due to reading the events from the
log, substituting the event strings in the
descriptions, and finally sending them
to the Tivoli Enterprise Monitoring
Server.

The large number of events can contain
many duplicate events.

Also, the Windows agent process,
kntcma.exe, may show high CPU usage
during Windows event log processing if
a large number of events are being
received in any of the Windows Event
Logs.

To resolve the high CPU usage, enable a duplicate event throttle that
drops duplicate events found during each reading of the event log.
Duplicate events are matched based on event ID, type, category, source,
and user ID. The description field of the event is not matched, thus any
information unique to the description is lost. Select Advanced -> Edit
Parms and add the desired parameters and values to the Env file. Save
the file. Select Yes to the recycle agent prompt.

The following environment variables can be set in the KNTENV file to
enable this duplicate event dropping throttle:

Apply to all event logs:

v NT_LOG_THROTTLE=x

Apply the following environment variable to each log separately:

v NT_{Event Log Name}_LOG_THROTTLE=x

Where:

v x=0, event drop throttle disabled

v x=1, drop all duplicate events every read cycle of the event log

v x>1, drop all duplicate events in groups of x every read cycle of the
event log

For example, if x=50 then duplicate events are drop in groups of 50.

You must specify the exact name of the event log you want to monitor.
The Windows Registry Editor lists the event log name as a key in either
of two paths:

v HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog

v HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
WINEVT\Channels

The name of the event log is the key listed under the Eventlog or
Channels key. For example, the Application event log has the key:

v HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog\
Application

Applying the Event Log Name to the environment variable, NT_{Event
Log Name}_LOG_THROTTLE, requires the conversion of any invalid
characters within the Event Log Name to a dash (-). Invalid characters
include a space ( ), asterisk (*), pound sign (#), vertical bar (|), back slash
(\), forward slash (/), colon (:), quote ("), less than sumbol (<), greater
than symbol (>), and question mark (?). For example, if the Event Log
Name is Microsoft-Windows-TaskScheduler/Operational, then the
environment variable to use in the KNTENV file would be
NT_Microsoft-Windows-TaskScheduler-Operational_LOG_THROTTLE=x
where x is defined above and the forward slash (/) was changed to a
dash (-).
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Table 10. Specific situation problems and solutions (continued)

Problem Solution

How do I collapse duplicate records for
Event Log Reports (Query View Results)
and enable the Event _Log
Duplicate_Record_Count attribute?

The Windows Event Log workspace has been updated to include a
'Duplicate Record Count' column. This column by default is always zero
unless the duplicate event log record processing is enabled. This
enablement can be done on any of the Windows Event Logs. Duplicate
events are matched based on event id, type, category, source, and user ID.
The description field of the event is not matched, thus any information
unique to the description is lost.

The following environment variables can be set in the KNTENV file to
enable the 'Duplicate Record Count' column.

Apply to all event logs:

v NT_LOG_DUPLICATE=x

Apply the following environment variable to each log separately:

v NT_{Event Log Name}_LOG_DUPLICATE=x

Where:

v x=0, event report duplicate disabled

v x=1, event report duplicate enabled

You must specify the exact name of the event log that you want to
monitor. If duplicate event log records are enabled, the following message
displays in the log: "LogManager enabling event report duplicate
record(XXX), EventLog: YYY" where XXX is the value specified for
NT_LOG_DUPLICATE and YYY is the name of the specific event log on
which this value applies. This message does not require a particular trace
level.

The Windows Registry Editor lists the event log name as a key in either
of two paths:

v HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog

v HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
WINEVT\Channels

The name of the event log is the key listed under the Eventlog or
Channels key. For example, the Application event log has the key:

v HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog\
Application

Applying the Event Log Name to the environment variable, NT_{Event
Log Name}_LOG_DUPLICATE, requires the conversion of any invalid
characters within the Event Log Name to a dash (-). Invalid characters
include a space ( ), asterisk (*), pound sign (#), vertical bar (|), back slash
(\), forward slash (/), colon (:), quote ("), less than sumbol (<), greater
than symbol (>), and question mark (?). For example, if the Event Log
Name is Microsoft-Windows-TaskScheduler/Operational, then the
environment variable to use in the KNTENV file would be
NT_Microsoft-Windows-TaskScheduler-Operational_LOG_DUPLICATE=x
where x is defined above and the forward slash (/) was changed to a
dash (-).
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Table 10. Specific situation problems and solutions (continued)

Problem Solution

You want to change the appearance of
situations when they are displayed in a
Workspace view.

1. Right-click an item in the Navigation tree.

2. Select Situations in the pop-up menu. The Situation Editor window is
displayed.

3. Select the situation that you want to modify.

4. Use the Status pull-down menu in the lower right of the window to
set the status and appearance of the Situation when it triggers.
Note: This status setting is not related to severity settings in IBM
Tivoli Enterprise Console.

Situations are triggered in the Tivoli
Enterprise Monitoring Server, but events
for the situation are not sent to the
Tivoli Enterprise Console® server. The
Tivoli Enterprise Monitoring Server is
properly configured for event
forwarding, and events for many other
situations are sent to the event server.

This condition can occur when a situation is only monitoring the status of
other situations. The event forwarding function requires an attribute
group reference in the situation in order to determine the correct event
class to use in the event. When the situation only monitors other
situations, no attribute groups are defined and the event class cannot be
determined. Because the event class cannot be determined, no event is
sent.

This is a limitation of the Tivoli Enterprise Monitoring Server event
forwarding function. Situations that only monitor other situations do not
send events to the event server.

A situation that is referencing percent
disk time returns values that are greater
than 100 percent.

Windows Performance Monitoring (perfmon) generates these metrics,
including percentage values that sometimes exceed 100. This behavior is
determined by the operating system and cannot be changed.

Monitoring activity requires too much
disk space.

Check the RAS trace logging settings that are described in “Setting RAS
trace parameters” on page 6. For example, trace logs grow rapidly when
you apply the ALL logging option.

Historical logging can consume large amounts of disk space. Be moderate
in your use of historical logging.

Monitoring activity requires too many
system resources.

Table 11 on page 22 describes the performance impact of specific attribute
groups. If possible, decrease your use of the attribute groups that require
greater system resources.

A formula that uses mathematical
operators is displayed to be incorrect.
For example, if you were monitoring
Linux, a formula that calculates when
Free Memory falls under 10 percent of
Total Memory does not work: LT
#’Linux_VM_Stats.Total_Memory’ / 10

This formula is incorrect because situation predicates support only logical
operators. Your formulas cannot have mathematical operators.
Note: The Situation Editor provides alternatives to math operators.
Regarding the example, you can select % Memory Free attribute and
avoid the need for math operators.

If you are running a Version 350
Monitoring Agent for Windows OS and
you choose to alter the views to include
a Version 610 UNICODE attribute, be
aware that data for this attribute is not
displayed and you see a blank column
in this view.

To enable Unicode and other features, upgrade the monitoring agent to
IBM Tivoli Monitoring, Version 6.2.0 or later.

You see the 'Unable to get attribute
name' error in the Tivoli Enterprise
Monitoring Server log after creating a
situation.

Install the agent's application support files on the Tivoli Enterprise
Monitoring Server, using the following steps:

1. Open the Manage Tivoli Enterprise Monitoring Services window.

2. Right-click the name of the monitoring server.

3. Select Advanced > Add TEMS Application Support in the pop-up
menu. Add application support if any for any agent that is missing
from the list. See in IBM Tivoli Monitoring Installation and Setup
Guide for more information on adding application support.
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Table 10. Specific situation problems and solutions (continued)

Problem Solution

Events received at the Tivoli Enterprise
Console server from IBM Tivoli
Monitoring do not have values for all
event attributes (slots) even though the
values are visible in workspace views.

The problem is due to a limitation in the IBM Tivoli Monitoring interface
code that generates Tivoli Enterprise Console events from situations. The
situation results are provided in a chain of buffers of 3000 bytes each. The
interface code currently extracts event information from only the first
buffer. When situations or agent table data expands in to a second buffer,
this additional data is not examined, and it is not included in events sent
to the Tivoli Enterprise Console server.

Tivoli Enterprise Console events from
IBM Tivoli Monitoring for IBM Tivoli
Monitoring 5.x migrated situations
receive parsing errors in the Tivoli
Enterprise Console server.

Complete the following two steps:

1. Ensure that you have the IBM Tivoli Monitoring Event Sync installed
on your Tivoli Enterprise Console server.

2. Obtain updated baroc files from IBM Tivoli Monitoring for the
monitoring agent's events. Updated baroc files are on the Tivoli
Enterprise Monitoring Server in the CANDLEHOME/CMS/TECLIB/itm5migr
directory.

You are receiving Tivoli Business
Systems Management events that cannot
be associated due to application_oid and
application_class not being set.

The problem is due to IBM Tivoli Monitoring sending Tivoli Enterprise
Console events for IBM Tivoli Monitoring 5.x migrated situations. These
events are not able to set the cited slot values. Replace the agent
forwarding script on the Tivoli Enterprise Console server with the version
of this file from the Tivoli Enterprise Monitoring Server in the
CANDLEHOME/CMS/TECLIB/itm5migr directory.

Consider performance impact of each attribute group
Table 11 lists the impact on performance (high, medium, or low) of each attribute group. The
multiple-instance attributes have been classified at the lowest level. That is, the performance overhead
will increase if you do not specify compare values for one or more key values.

When you want to prevent impact on performance by any of the attribute groups listed in Table 11, you
must avoid referencing that attribute group, as suggested in this list:
v Avoid over use of the attribute group.
v Use caution when selecting workspaces that reference the attribute group.
v Avoid over use of the situations that reference the attribute group by using the "Undistributed

situations" option in the Situation Editor.
v Use caution when enabling historical reporting that references the attribute group.
v Avoid using the "Auto Refresh" refresh feature in a Workspace because this option causes a refresh of

data for all attribute groups.

Note: If pre-defined situations are running against the NT_Event_Log attribute group, and there is a
high frequency of events, enhance the filtering criteria to prevent high CPU utilization.

See the IBM Tivoli Monitoring User's Guide for additional information on controlling attribute group usage.

Table 11. Performance Impact by attribute group

Attribute group High Medium Low

Active Server Pages U

DHCP Server U

DNS Dynamic Update U

DNS Memory U

DNS Query U

DNS WINS U
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Table 11. Performance Impact by attribute group (continued)

Attribute group High Medium Low

DNS Zone Transfer U

FTP Server Statistics U

FTP Service U

HTTP Content Index U

HTTP Service U

ICMP Statistics U

IIS Statistics U

Indexing Service Filter U

Indexing Service U

IP Statistics U

Job Object Details U

Job Object U

Mount Point U

MSMQ Information Store U

MSMQ Queue U

MSMQ Service U

MSMQ Sessions U

Network Interface U

Network Segment U

NNTP Commands U

NNTP Server U

NT_BIOS Information U

NT_Cache U

NT_Computer Information U

NT_Device Dependencies U

NT_Devices U

NT_Event Log

The performance impact of the NT_Event Log attribute
group is high when you display reports in the
workspace, due to the time it takes to perform the
queries. The performance impact is low when a
situation targets a single item in the Event Log attribute
group.

U

NT_File Change U

NT_File Trend U

NT_IP Address U

NT_Logical Disk U

NT_Memory U

NT_Monitored Logs U

NT_Network Port U

NT_Objects U
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Table 11. Performance Impact by attribute group (continued)

Attribute group High Medium Low

NT_Paging File U

NT_Physical Disk U

NT_Port U

NT_Print Job U

NT_Printer U

NT_Processor U

NT_Processor_Information U

NT_Processor Summary U

NT_Redirector U

NT_Registry U

NT_Server U

NT_Server Work Queues U

NT_Service Dependencies U

NT_Services U

NT_System U

NT_Thread U

Print Queue U

Process IO U

RAS Port U

RAS Total U

SMTP Server U

TCP Statistics U

UDP Statistics U

VMWare Memory U

VMWare Performance U

Web Service U

Problems with configuration of situations
Table 12 lists problems that might occur with situations.

Table 12. Problems with configuring situations that you solve in the Situation Editor

Problem Solution

Note: To display the Situation Editor, perform these steps:
1. Launch the Tivoli Enterprise Portal.
2. Click Edit > Situation Editor.
3. In the tree view, choose the agent whose situation you want to modify.
4. Choose the situation in the list. The Situation Editor view is displayed.

The situation for a specific agent is
not visible in the Tivoli Enterprise
Portal.

Open the Situation Editor. Access the All managed servers view. If the situation
is absent, confirm that application support for Monitoring Agent for Windows
OS has been added to the monitoring server. If not, add application support to
the server, as described in the IBM Tivoli Monitoring Installation and Setup Guide.
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Table 12. Problems with configuring situations that you solve in the Situation Editor (continued)

Problem Solution

The monitoring interval is too
long.

Access the Situation Editor view for the situation that you want to modify.
Check the Sampling interval area in the Formula tab. Adjust the time interval
as needed.

The situation did not activate at
startup.

Manually recycle the situation as follows:

1. Right-click the situation and choose Stop Situation.

2. Right-click the situation and choose Start Situation.

Note: You can permanently avoid this problem by placing a check mark in the
Run at Startup option of the Situation Editor view for a specific situation.

The situation is not displayed. Click the Action tab and check whether the situation has an automated
corrective action. This action can occur directly or through a policy. The
situation might be resolving so quickly that you do not see the event or the
update in the graphical user interface.

An Alert event has not occurred
even though the predicate has been
properly specified.

Check the logs, reports, and workspaces.

A situation fires on an unexpected
managed object.

Confirm that you have distributed and started the situation on the correct
managed system.

The product did not distribute the
situation to a managed system.

Click the Distribution tab and check the distribution settings for the situation.

The situation does not fire.

Incorrect predicates are present in
the formula that defines the
situation. For example, the
managed object shows a state that
normally triggers a monitoring
event, but the situation is not true
because the wrong attribute is
specified in the formula.

In the Formula tab, analyze predicates as follows:

1. Click the fx icon in the upper-right corner of the Formula area. The Show
formula window is displayed.

a. Confirm the following details in the Formula area at the top of the
window:
v The attributes that you intend to monitor are specified in the formula.
v The situations that you intend to monitor are specified in the formula.
v The logical operators in the formula match your monitoring goal.
v The numerical values in the formula match your monitoring goal.

b. (Optional) Click the Show detailed formula check box in the lower left
of the window to see the original names of attributes in the application
or operating system that you are monitoring.

c. Click OK to dismiss the Show formula window.

2. (Optional) In the Formula area of the Formula tab, temporarily assign
numerical values that will immediately trigger a monitoring event. The
triggering of the event confirms that other predicates in the formula are
valid.
Note: After you complete this test, you must restore the numerical values
to valid levels so that you do not generate excessive monitoring data based
on your temporary settings.

Table 13. Problems with configuration of situations that you solve in the Workspace area

Problem Solution

Situation events are not displayed
in the Events Console view of the
workspace.

Associate the situation with a workspace.
Note: The situation does not need to be displayed in the workspace. It is
sufficient that the situation be associated with any workspace.
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Table 13. Problems with configuration of situations that you solve in the Workspace area (continued)

Problem Solution

You do not have access to a
situation.

Note: You must have administrator privileges to perform these steps.

1. Select Edit > Administer Users to access the Administer Users window.

2. In the Users area, select the user whose privileges you want to modify.

3. In the Permissions tab, Applications tab, and Navigator Views tab, select
the permissions or privileges that correspond to the user's role.

4. Click OK.

A managed system seems to be
offline.

1. Select Physical View and highlight the Enterprise Level of the navigator
tree.

2. Select View > Workspace > Managed System Status to see a list of
managed systems and their status.

3. If a system is offline, check network connectivity and status of the specific
system or application.

Table 14. Problems with configuration of situations that you solve in the Manage Tivoli Enterprise Monitoring Services
window

Problem Solution

After an attempt to restart the
agents in the Tivoli Enterprise
Portal, the agents are still not
running.

For UNIX, NetWare, or Windows, log on to the applicable system and perform
the appropriate queries.

The Tivoli Enterprise Monitoring
Server is not running.

Check the system status and check the appropriate IBM Tivoli Monitoring logs.

The managed objects you created
are firing on incorrect managed
systems.

Check the managed system distribution on both the situation and the managed
object settings sheets.

26 IBM Tivoli Monitoring: Windows OS Agent Troubleshooting Guide



Documentation library

Various publications are relevant to the use of IBM Tivoli Monitoring and to the commonly shared
components of Tivoli Management Services.

These publications are listed in the following categories:
v IBM Tivoli Monitoring library
v Related publications

Documentation is delivered in the IBM Tivoli Monitoring and OMEGAMON XE Information Center at
http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp and also in the Files section of the
Application Performance Management community.

For information about accessing and using the publications, select IBM Tivoli Monitoring → Using the
publications in the Contents pane of the IBM Tivoli Monitoring and OMEGAMON XE Information
Center at http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp.

To find a list of new and changed publications, click the New in this release topic on the IBM Tivoli
Monitoring welcome page. To find publications from the previous version of a product, click Previous
versions under the name of the product in the Contents pane.

IBM Tivoli Monitoring library
The IBM Tivoli Monitoring library provides information about the commonly shared components of
Tivoli Management Services.
v Quick Start Guide

Introduces the components of IBM Tivoli Monitoring.
v Installation and Setup Guide, SC22-5445

Provides instructions for installing and configuring IBM Tivoli Monitoring components on Windows,
Linux, and UNIX systems.

v Installation Roadmap available on Service Management Connect
Provides a roadmap that covers the installation of IBM Tivoli Monitoring.

v High Availability Guide for Distributed Systems, SC22-5455
Gives instructions for several methods of ensuring the availability of the IBM Tivoli Monitoring
components.

v Program Directory for IBM Tivoli Management Services on z/OS, GI11-4105
Gives instructions for the SMP/E installation of the Tivoli Management Services components on z/OS®.

v Administrator's Guide, SC22-5446
Describes the support tasks and functions required for the Tivoli Enterprise Portal Server and clients,
including Tivoli Enterprise Portal user administration.

v Command Reference available on Service Management Connect
Provides detailed syntax and parameter information, as well as examples, for the commands you can
use in IBM Tivoli Monitoring.

v Messages available on Service Management Connect
Lists and explains messages generated by all IBM Tivoli Monitoring components and by z/OS-based
Tivoli Management Services components (such as Tivoli Enterprise Monitoring Server on z/OS and
TMS:Engine).

v Troubleshooting Guide available on Service Management Connect
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Provides information to help you troubleshoot problems with the software.
v Tivoli Enterprise Portal User's Guide available on Service Management Connect

Complements the Tivoli Enterprise Portal online help. The guide provides hands-on lessons and
detailed instructions for all Tivoli Enterprise Portal features.

v Tivoli Enterprise Portal online help
Provides context-sensitive reference information about all features and customization options of the
Tivoli Enterprise Portal. Also gives instructions for using and administering the Tivoli Enterprise
Portal.

Documentation for the base agents
If you purchased IBM Tivoli Monitoring as a product, you received a set of base monitoring agents as
part of the product. If you purchased a monitoring agent product (for example, an OMEGAMON XE
product) that includes the commonly shared components of Tivoli Management Services, you did not
receive the base agents.

The following publications provide information about using the base agents.
v Agentless operating system monitors

– Agentless Monitoring for Windows Operating Systems User's Guide, SC23-9765
– Agentless Monitoring for AIX Operating Systems User's Guide, SC23-9761
– Agentless Monitoring for HP-UX Operating Systems User's Guide, SC23-9763
– Agentless Monitoring for Solaris Operating Systems User's Guide, SC23-9764
– Agentless Monitoring for Linux Operating Systems User's Guide, SC23-9762

v OS agent documentation is delivered in the following locations:

Agent Installation and Configuration Guide
Available in the Information Center:
– IBM i OS Agent Installation and Configuration Guide, SC27-5653
– Linux OS Agent Installation and Configuration Guide, SC27-5652
– UNIX OS Agent Installation and Configuration Guide, SC27-5651
– Windows OS Agent Installation and Configuration Guide, SC27-5650

Agent Reference
Available on Service Management Connect

Agent Troubleshooting Guide
Available on Service Management Connect

Infrastructure Management Dashboards for Servers Reference
Available on Service Management Connect

v Warehouse agent documentation is delivered in the following locations:

Agent Installation and Configuration Guide
Available in the Information Center:
– Warehouse Proxy Agent Installation and Configuration Guide, SC27-5655
– Warehouse Summarization and Pruning Agent Installation and Configuration Guide, SC27-5654

Agent Reference
Available on Service Management Connect

Agent Troubleshooting Guide
Available on Service Management Connect

v System P agents
– AIX Premium Agent User's Guide, SA23-2237
– CEC Base Agent User's Guide, SC23-5239
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– HMC Base Agent User's Guide, SA23-2239
– VIOS Premium Agent User's Guide, SA23-2238

v Other base agents
– Agent Builder User's Guide, SC32-1921
– Performance Analyzer User’s Guide, SC27-4004
– Systems Director base Agent User’s Guide, SC27-2872
– Tivoli Log File Agent User’s Guide, SC14-7484
– Tivoli zEnterprise Monitoring Agent User’s Guide, SC14-7359 and the Tivoli zEnterprise Monitoring Agent

Installation and Configuration Guide, SC14-7358

Related publications
For information about related products and publications select OMEGAMON XE shared publications or
other entries in the Contents pane of the IBM Tivoli Monitoring and OMEGAMON XE Information
Center.

You can access the IBM Tivoli Monitoring and OMEGAMON XE Information Center at
http://pic.dhe.ibm.com/infocenter/tivihelp/v61r1/index.jsp .

You can also access other information centers at IBM Tivoli Documentation Central (https://
www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Documentation
%20Central).

Tivoli Monitoring community on Service Management Connect
Connect, learn, and share with Service Management professionals: product support technical experts who
provide their perspectives and expertise.

For information about Tivoli products, see the Application Performance Management community on SMC
at IBM Service Management Connect > Application Performance Management (http://www.ibm.com/
developerworks/servicemanagement/apm).

For introductory information, see IBM Service Management Connect (http://www.ibm.com/
developerworks/servicemanagement).

Use Service Management Connect in the following ways:
v Become involved with transparent development, an ongoing, open engagement between other users

and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

v Connect one-on-one with the experts to collaborate and network about Tivoli and the (enter your
community name here) community.

v Read blogs to benefit from the expertise and experience of others.
v Use wikis and forums to collaborate with the broader user community.

Other sources of documentation
You can obtain additional technical documentation about monitoring products from other sources.
v Tivoli wikis

IBM Service Management Connect > Application Performance Management (http://www.ibm.com/
developerworks/servicemanagement/apm) includes a list of relevant Tivoli wikis that offer best
practices and scenarios for using Tivoli products, white papers contributed by IBM employees, and
content created by customers and business partners.
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Two of these wikis are of particular relevance to IBM Tivoli Monitoring:
– The IBM Tivoli Monitoring Wiki (https://www.ibm.com/developerworks/community/wikis/

home?lang=en#!/wiki/Tivoli%20Monitoring) provides information about IBM Tivoli Monitoring and
related distributed products, including IBM Tivoli Composite Application Management products.

– The Tivoli System z® Monitoring and Application Management Wiki provides information about the
OMEGAMON XE products, NetView® for z/OS, Tivoli Monitoring Agent for z/TPF, and other
System z monitoring and application management products.

v IBM Integrated Service Management Library
http://www.ibm.com/software/brandcatalog/ismlibrary/
IBM Integrated Service Management Library is an online catalog that contains integration
documentation and other downloadable product extensions.

v Redbooks®

http://www.redbooks.ibm.com/
IBM Redbooks and Redpapers include information about products from platform and solution
perspectives.

v Technotes
Technotes provide the latest information about known product limitations and workarounds. You can
find Technotes through the IBM Software Support Web site at http://www.ibm.com/software/
support/.
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Support information

If you have a problem with your IBM software, you want to resolve it quickly. IBM provides ways for
you to obtain the support you need.

Online
The following sites contain troubleshooting information:
v Go to the IBM Support Portal (http://www.ibm.com/support/entry/portal/software) and

follow the instructions.
v Go to IBM Service Management Connect > Application Performance Management

(http://www.ibm.com/developerworks/servicemanagement/apm) and select the appropriate
wiki.

IBM Support Assistant
The IBM Support Assistant (ISA) is a free local software serviceability workbench that helps you
resolve questions and problems with IBM software products. The ISA provides quick access to
support-related information and serviceability tools for problem determination. To install the ISA
software, go to IBM Support Assistant (http://www-01.ibm.com/software/support/isa).

Troubleshooting Guide
For more information about resolving problems, see the product's Troubleshooting Guide.

Using IBM Support Assistant
The IBM Support Assistant is a free, stand-alone application that you can install on any workstation. You
can then enhance the application by installing product-specific plug-in modules for the IBM products you
use.

The IBM Support Assistant saves you the time it takes to search the product, support, and educational
resources. The IBM Support Assistant helps you gather support information when you need to open a
problem management record (PMR), which you can then use to track the problem.

The product-specific plug-in modules provide you with the following resources:
v Support links
v Education links
v Ability to submit problem management reports

For more information, and to download the IBM Support Assistant, see http://www.ibm.com/software/
support/isa. After you download and install the IBM Support Assistant, follow these steps to install the
plug-in for your Tivoli product:
1. Start the IBM Support Assistant application.
2. Select Updater on the Welcome page.
3. Select New Properties and Tools or select the New Plug-ins tab (depending on the version of IBM

Support Assistant installed).
4. Under Tivoli, select your product, and then click Install. Be sure to read the license and description.

If your product is not included on the list under Tivoli, no plug-in is available yet for the product.
5. Read the license and description, and click I agree.
6. Restart the IBM Support Assistant.
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Obtaining fixes
A product fix might be available to resolve your problem. To determine which fixes are available for your
Tivoli software product, follow these steps:
1. Go to the IBM Software Support website at http://www.ibm.com/software/support.
2. Under Select a brand and/or product, select Tivoli.

If you click Go, the Search within all of Tivoli support section is displayed. If you don't click Go,
you see the Select a product section.

3. Select your product and click Go.
4. Under Download, click the name of a fix to read its description and, optionally, to download it.

If there is no Download heading for your product, supply a search term, error code, or APAR number
in the field provided under Search Support (this product), and click Search.

For more information about the types of fixes that are available, see the IBM Software Support Handbook at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/home.html.

Receiving weekly support updates
To receive weekly e-mail notifications about fixes and other software support news, follow these steps:
1. Go to the IBM Software Support website at http://www.ibm.com/software/support.
2. Click My support in the far upper-right corner of the page under Personalized support.
3. If you have already registered for My support, sign in and skip to the next step. If you have not

registered, click register now. Complete the registration form using your e-mail address as your IBM
ID and click Submit.

4. The Edit profile tab is displayed.
5. In the first list under Products, select Software. In the second list, select a product category (for

example, Systems and Asset Management). In the third list, select a product sub-category (for
example, Application Performance & Availability or Systems Performance). A list of applicable
products is displayed.

6. Select the products for which you want to receive updates.
7. Click Add products.
8. After selecting all products that are of interest to you, click Subscribe to email on the Edit profile

tab.
9. In the Documents list, select Software.

10. Select Please send these documents by weekly email.
11. Update your e-mail address as needed.
12. Select the types of documents you want to receive.
13. Click Update.

If you experience problems with the My support feature, you can obtain help in one of the following
ways:

Online
Send an e-mail message to erchelp@ca.ibm.com, describing your problem.

By phone
Call 1-800-IBM-4You (1-800-426-4968).

Contacting IBM Software Support
IBM Software Support provides assistance with product defects. The easiest way to obtain that assistance
is to open a PMR or ETR directly from the IBM Support Assistant.
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Before contacting IBM Software Support, your company must have an active IBM software maintenance
contract, and you must be authorized to submit problems to IBM. The type of software maintenance
contract that you need depends on the type of product you have:
v For IBM distributed software products (including, but not limited to, Tivoli, Lotus®, and Rational®

products, as well as DB2® and WebSphere® products that run on Windows or UNIX operating
systems), enroll in Passport Advantage® in one of the following ways:

Online
Go to the Passport Advantage website at http://www-306.ibm.com/software/howtobuy/
passportadvantage/pao_customers.htm .

By telephone
For the telephone number to call in your country, go to the IBM Software Support website at
http://techsupport.services.ibm.com/guides/contacts.html and click the name of your
geographic region.

v For customers with Subscription and Support (S & S) contracts, go to the Software Service Request
website at https://techsupport.services.ibm.com/ssr/login.

v For customers with Linux, iSeries®, pSeries, zSeries, and other support agreements, go to the IBM
Support Line website at http://www.ibm.com/services/us/index.wss/so/its/a1000030/dt006.

v For IBM eServer™ software products (including, but not limited to, DB2 and WebSphere products that
run in zSeries, pSeries, and iSeries environments), you can purchase a software maintenance agreement
by working directly with an IBM sales representative or an IBM Business Partner. For more information
about support for eServer software products, go to the IBM Technical Support Advantage website at
http://www.ibm.com/servers/eserver/techsupport.html.

If you are not sure what type of software maintenance contract you need, call 1-800-IBMSERV
(1-800-426-7378) in the United States. From other countries, go to the contacts page of the IBM Software
Support Handbook on the web at http://www14.software.ibm.com/webapp/set2/sas/f/handbook/
home.html and click the name of your geographic region for telephone numbers of people who provide
support for your location.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law :

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming
to IBM's application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows: © (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 2013. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.
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